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BAB III  

METODE PENELITIAN 

 

A. Jenis dan Pendekatan Penelitian 

1. Jenis Penelitian  

Jenis penelitian ini adalah experiment research, yaitu penelitian yang 

dilakukan dengan meneliti pengaruh perlakuan terhadap perilaku yang timbul 

sebagai akibat perlakuan.1 Pada penelitian ini bertujuan untuk melihat 

pengaruh dari penggunaan worksheet materi asam basa berbasis kearifan lokal 

terhadap hasil belajar siswa kelas XI MIA di SMAN 9 Banjarmasin  

2. Pendekatan Penelitian 

Salah satu aspek penting dalam suatu kegiatan penelitian pendidikan 

adalah menentukan pendekatan penelitian. Pendekatan penelitian ini 

menggunakan penelitian kuantitatif, yaitu metode yang berlandaskan pada 

filsafat positivisme digunakan untuk meneliti pada populasi atau sampel 

tertentu, pengumpulan data menggunakan instrumen penelitian, analisis data 

bersifat kuantitatif atau statistik, dengan tujuan untuk menguji hipotesis yang 

telah ditetapkan.2 Pendekatan kuantitatif bertujuan untuk menguji teori, 

membangun fakta, menunjukkan hubungan antar variabel, memberikan 

deskripsi statistik, menaksir dan meramalkan hasilnya. Pendekatan kuantitatif 

                                                             
1 Syofian Siregar, Statistik Deskriptif untuk Penelitian, (Jakarta: PT Raja Grafindo 

Persada, 2010), h. 103 
2 Sugiyono, Metode Penelitian Pendekatan Kuantitatif, Kualitatif, dan R & D, (Bandung: 

Alfabeta, 2010), h.14 
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mementingkan adanya varibel-variabel sebagai objek penelitian dan variabel-

variabel tersebut harus didefinisikan dalam bentuk operasional variabel 

masing-masing.3 

Selain jenis dan pendekatan penelitian, desain penelitian yang 

digunakan dalam penelitian ini adalah desain kelompok kontrol pretest dan 

posttest (Pretest-Posttest Control Group Design). Subjek dalam penelitian ini 

dikelompokkan menjadi dua kelompok penelitian yang mendapat perlakuan 

berbeda. Masing-masing kelompok mendapatkan pretest (T1) dan posttest (T2). 

Tabel desain penelitian ini secara rinci tercantum pada Tabel V berikut ini. 

Tabel V Desain Penelitian 

Kelas Pretest Perlakuan Posttest 

Kontrol T1 X1 T2 

Eksperimen T1 X2 T2 

 

Keterangan: 

T1  = Pretest (tes awal). 

T2  = Posttest (tes akhir). 

X1  = Perlakuan di kelas kontrol (pembelajaran konvensional). 

X2 = Perlakuan di kelas eksperimen (pembelajaran dengan menggunakan 

worksheet materi asam basa berbasisi kearifan lokal). 

Hal pertama yang akan dilakukan dalam penelitian ini adalah 

menetapkan kelompok yang akan dijadikan sebagai kelompok eksperimen dan 

sebagai kelompok kontrol. Kelompok yang menggunakan pembelajaran 

                                                             
3 Ahmad Tanzeh, Metodologi Penelitian Praktis, (Yogyakarta: Teras, 2011), h.10 
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dengan penggunaan worksheet materi asam basa berbasis kearifan lokal 

ditetapkan sebagai kelas eksperimen, sedangkan kelompok yang menggunakan 

pembelajaran secara konvensional ditetapkan sebagai kelas kontrol. 

Sebelum diberi perlakuan (X), kelas eksperimen dan kelas kontrol 

diberikan pretest terlebih dahulu, kemudian dilanjutkan dengan memberikan 

perlakuan pada kelas eksperimen dengan pembelajaran menggunakan 

worksheet materi asam basa berbasis kearifan lokal dan kelas kontrol dengan 

pembelajaran konvensional. Hal berikutnya yang dilakukan adalah kedua kelas 

diberikan posttest, hasilnya akan dibandingkan dengan skor pretest sehingga 

diperoleh selisih antara skor pretest dan posttest. 

B. Subjek dan Objek Penelitian 

 1. Subjek Penelitian 

Subjek dalam penelitian ini terdiri dari populasi dan sampel sebagai 

berikut: 

a. Populasi 

Populasi merupakan keseluruhan subjek yang ingin diteliti, anggota 

populasi dapat berupa benda mati maupun benda hidup dan manusia yang 

bersifat atau dapat diukur dan diamati.4 

Menurut Sugiyono, “ populasi adalah wilayah generalisasi yang terdiri 

atas: objek/subjek yang mempunyai kualitas dan karakteristik tertentu 

yang ditetapkan oleh peneliti untuk dipelajari dan kemudian ditarik 

kesimpulannya sedangkan sampel adalah bagian dari jumlah dan 

karakteristik yang dimiliki oleh populasi tersebut”.5 

 

                                                             
4 Syahrun dan Salim, Metodologi Penelitian Kuantitaif, (Bandung: Cita Pustaka Media, 

2012), h. 113. 
5 Sugiyono, Metode Penelitian Pendekatan Kuantitatif, Kualitatif, dan R & D, Op.Cit.,  h. 

168. 
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Berdasarkan definisi di atas, maka dapat diambil batasan pengertian 

bahwa populasi adalah keseluruhan unsur subjek sebagai sumber data 

dengan karakteristik tertentu dalam sebuah penelitian. 

Populasi dalam penelitian ini adalah seluruh siswa dan siswi kelas XI 

MIA SMAN 9 Banjarmasin dengan 4 kelas dan berjumlah 137 orang. 

b. Sampel 

Menurut Arikunto, mengatakan bahwa: “sampel adalah bagian dari 

populasi (sebagian atau wakil populasi yang diteliti). Sampel penelitian 

adalah sebagian dari populasi yang diambil sebagai sumber data dan dapat 

mewakili seluruh populasi”. Sugiyono memberikan pengertian bahwa: 

“sampel adalah sebagian dari jumlah dan karakteristik yang dimiliki oleh 

populasi”. 

 

Beberapa pendapat di atas dapat diambil kesimpulan bahwa sampel 

adalah bagian dari populasi yang mempunyai ciri-ciri atau keadaan 

tertentu yang akan diteliti, karena tidak semua data dan informasi akan 

diproses, dan tidak semua orang atau benda akan diteliti melainkan cukup 

dengan menggunakan sampel yang mewakilinya.6 

Sampel ini digunakan jika populasi yang diteliti jumlahnya besar dan 

tidak memungkinkan peneliti mempelajari seluruh populasinya. 

Pengambilan sampel dalam penelitian ini adalah dengan menggunakan 

teknik Purposive Sampling  yang artinya teknik pengambilan sampel tidak 

secara acak, tetapi ditentukan sendiri oleh peneliti. Kriteria-kriteria sampel 

yang diperhatikan dalam penenlitian ini dapat dilihat pada tabel VI berikut. 

  

                                                             
6 Dominikus Dolet Unaradjan, Metode Penelitian Kuantitatif, (Jakarta:Grafindo, 2019), 

h.112 



40 

 

 

 

 

Tabel VI Kriteria Pengambilan Sampel 

No Kriteria 

1 Bahan belajar yang digunakan oleh siswa-siswi adalah LKS 

dari SMAN 9 Banjarmasin, masih belum ada penggunaann 

worksheet berbasis kearifan lokal pada mata pelajaran kimia 

materi asam basa. 

2 Sampel yang diteliti sudah diamati selama 2 bulan sejak 

peneliti melaksanakan PPL 2 di SMAN 9 Banjarmasin. 

 

Maka sampel dalam penelitian yang diambil adalah kelas XI MIA 3 

dan XI MIA 4 SMAN 9 Banjarmasin, lebih jelasnya dapat dilihat pada 

tabel VII berikut. 

Tabel VII Sampel Penelitian 

Kelas Perlakuan Jumlah 

XI MIA 3 Kelas kontrol 19 

XI MIA 4 Kelas eksperimen 29 

 

2. Objek Penelitian 

Objek dalam penelitian ini terdiri dari variabel bebas dan variabel 

terikat sebagai berikut: 

a. Variabel Bebas 

Variabel bebas adalah variabel yang menyebabkan atau 

mempengaruhi, yaitu faktor-faktor yang diukur, dimanipulasi, atau dipilih 

oleh peneliti untuk menentukan hubungan antara fenomena yang 

diobservasi atau diamati.7 

                                                             
7 Punaji Setyosari, Metode Penelitian Pendidikan & Pengembangan, (Jakarta: 

Prenadamedia, 2010), h. 164.   



41 

 

 

 

Menurut Sogiyono, variabel bebas merupakan variabel yang 

mempengaruhi dan menjadi perubahan atau timbulnya variabel terikat8. 

Variabel bebas dalam penelitian ini adalah pengaruh penggunaan 

worksheet (X). 

b. Variabel Terikat 

Variabel terikat/dependen (variabel dampak) merupakan variabel 

hasil/dampak/akibat dari variabel bebas/perlakuan. Variabel terikat 

umumnya menjadi tujuan penelitian, sumber masalah yang ingin 

ditingkatkan kualitasnya. Variabel terikat dipengaruhi atau menjadi akibat 

karena adanya variabel bebas.9 Variabel terikat dalam penelitian ini adalah 

hasil belajar siswa (Y) kelas XI MIA SMAN 9 Banjarmasin. 

Hubungan antara kedua variabel tersebut dapat dilihat pada skema 

berikut: 

SKEMA 

Variabel bebas Variabel terikat 

X Y 

Keterangan: 

X = Penggunaan worksheet materi asam basa berbasis kearifan lokal dalam 

pembelajaran kimia. 

Y = Hasil belajar siswa kelas XI MIA SMAN 9 Banjarmasin. 

 

                                                             
8 Sugiyono, Metode Penelitian Pendekatan Kuantitatif, Kualitatif, dan R & D, Op.Cit.,  h. 

61. 
9 Ibid., h. 61.  
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3. Tempat Penelitian 

Penelitian ini dilaksanakan di SMAN 9 Banjarmasin yang terletak di Jl. 

Tatah Bangkal No. 01 Rt. 32 Kelayan Timur Kecamatan Banjarmasin Selatan 

untuk mata pelajaran kimia. Pemilihan sekolah ini sebagai tempat penelitian 

karena memiliki kelas XI MIA yang paralel, yaitu pada kelas XI MIA terdapat 

4 kelas, meski 4 kelas MIA melebihi target untuk pegambilan sampel karena 

pada penelitian ini hanya membutuhkan 2 kelas MIA saja, namun akan diambil 

2 kelas MIA pilihan sesuai dengan standar permasalahan yang akan diteliti 

sesuai dengan bentuk penelitian yang akan dilakukan. Selain itu, dari pihak 

sekolah baik itu kepala sekolah maupun segenap dewan guru yang 

bersangkutan memperbolehkan peneliti untuk melakukan penelitian di sekolah 

ini. 

4. Waktu Penelitian 

Penelitian ini dilaksanakan pada semester genap tahun ajaran 

2020/2021. Lama waktu penelitian selama 1 bulan dari tanggal 18 Februari-19 

Maret 2021. Penelitian ini dilaksanakan secara daring, menyesuaikan dengan 

kebijakan dari SMAN 9 Banjarmasin karena masih dalam keadaan covid-19. 

C. Data dan Sumber Data 

Data dan sumber data dalam penelitian ini terdiri dari datasumber data, 

instrumen penelitian, dan pengembangan instrumen penelitian sebagai berikut: 
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1. Data 

Data yang digali dalam penelitian ini ada dua macam yaitu data primer dan 

data sekunder, secara rinci kedua data akan dibahas di bawah ini: 

a. Data Primer 

Data primer yang akan digali dalam penelitian ini adalah sebagai berikut: 

1) Data dari hasil pretest kelas kontrol dan kelas ekperimen yang 

berkenaan dengan kemampuan awal siswa dalam memahami materi 

asam basa. 

2) Data dari hasil posttest  kelas kontrol dan kelas eksperimen yang 

berkenaan dengan hasil belajar siswa dalam memahami materi asam 

basa.  

b. Data Sekunder 

Penelitian ini juga menggunakan data sekunder yang diperoleh secara tidak 

langsung untuk melengkapi dan mendukung data primer. Data sekuder dari 

penelitian ini bersumber dari dokumen-dokumen terkait dengan sekolah 

SMAN 9 Banjarmasin, yaitu meliputi : 

1) Gambaran umum SMAN 9 Banjarmasin. 

2) Visi dan misi sekolah SMAN 9 Banjarmasin. 

3) Keadaan siswa, guru dan staf tata usaha SMAN 9 Banjarmasin. 
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2. Sumber Data 

Sumber data merupakan subjek dari mana data diperoleh, diambil, 

dan dikumpulkan10. Sumber data dari penelitian ini adalah sebagai berikut:  

a. Responden, yaitu guru mata pelajaran kimia, dan siswa SMAN 9 

Banjarmasin. 

b. Informan, yaitu orang-orang yang memberikan informasi sebagai penunjang 

terhadap data-data yang diperoleh dari responden, antara lain staf tata usaha 

dan guru-guru. 

c. Dokumentasi, yaitu soal tes dan semua catatan atau arsip yang memuat data-

data atau informasi yang mendukung dalam penelitian. 

3. Instrumen Penelitian 

Prinsip dalam meneliti adalah melakukan pengukuran, maka harus ada alat 

ukur yang baik. Alat ukur dalam penelitian biasanya dinamakan instrumen 

penelitian11. Secara fungsional kegunaan instrumen penelitian adalah untuk 

memperoleh data yang diperlukan ketika peneliti sudah menginjak pada 

langkah pengumpulan informasi di lapangan. Tetapi perlu disadari bahwa 

dalam penelitian kuantitatif, membuat instrumen penelitian, menentukan 

hipotesis dan pemilihan statistika adalah termasuk kegiatan yang  harus dibuat 

secara intensif, sebelum peneliti memasuki lapangan. 

Instrumen merupakan alat bantu bagi peneliti dalam menggunakan metode 

pengumpulan data. Dengan demikian ada keterkaitan antara pendekatan 

                                                             
10 Arikunto, Prosedur Penelitian Suatu Pendekatan Praktik, (Jakarta: Rineka Cipta, 2010), 

h. 172. 
11 Sugiyono, Metode Penelitian Pendekatan Kuantitatif, Kualitatif, dan R & D, Op.Cit., h. 

148 
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dengan instrumen pengumpulan data. Keberhasilan peneliti banyak ditentukan 

oleh instrumen penelitian yang digunakan, karena data yang dikumpulkan 

merupakan kunci pokok dalam kegiatan penelitian dan sekaligus sebagai mutu 

hasil penelitian. 

4. Pengembangan Instrumen Penelitian 

a. Instrumen hasil belajar 

Instrumen hasil belajar merupakan seperangkat alat ukur tes yang 

berupa sejumlah soal tes pengukuran, yang disusun berbentuk soal obejktif 

yang dirancang oleh peneliti. Instrumen yang digunakan dalam penelitian 

ini adalah soal pilihan ganda. 

Penyusunan instrumen tes ini dilakukan dengan memperhatikan 

beberapa hal berikut: 

1) Instrumen tes mengacu pada kurikulum 2013. 

2) Instrumen tes mengacu pada indikator pencapaian dari worksheet materi 

asam basa berbasis kearifan lokal. 

3) Instrumen tes berpedoman pada kriteria alat ukur yang baik, sekurang-

kurangnya memenuhi validitas dan reabilitas. 

b. Instrumen non tes hasil belajar 

Instrumen non tes yang digunakan adalah observasi, wawancara, dan 

dokumentasi. Lembar observasi pembelajaran untuk mengamati aktivitas 

siswa dalam proses pembelajaran. Wawancara dilakukan untuk memberikan 

pertanyaan-pertanyaan kepada responden mengenai hal-hal yang berkaitan 
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dengan kegiatan penelitian. Dokumentasi dilakukan untuk memperoleh 

dokumen-dokumen atau data-data penunjang dalam penelitian. 

D. Teknik Pengumpulan Data 

Teknik pengumpulan data merupakan cara yang ditempuh peneliti 

dalam mengumpulkan data penelitian. Sesuai dengan bentuk pendekatan 

penelitian kuantitatif dan sumber data yang digunakan, maka teknik 

pengumpulan data yang digunakan adalah:  

a. Tes 

Tes adalah serangkaian pertanyaan atau latihan serta alat lain yang 

digunakan untuk mengukur keterampilan, pengetahuan intelegensi, 

kemampuan atau bakat yang dimiliki oleh individu atau kelompok.12 

Bentuk tes yang digunakan adalah bentuk tes objektif untuk 

mengukur hasil belajar siswa terhadap materi asam basa. Tes dilakukan 

dalam bentuk tes awal (pretest) sebelum memberikan perlakuan (treatment) 

dan tes akhir (posttest) digunakan untuk mengukur hasil belajar siswa dalam 

memahami materi asam basa setelah diberikan perlakuan (treatment) yang 

berbeda. Tes yang diberikan pada kelas kontrol dan kelas eksperimen 

memiliki bentuk dan kualitas sama. Data tes inilah yang dijadikan acuan 

untuk menarik kesimpulan pada akhir penelitian. 

  

                                                             
12 Ibid., h.193 
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b. Observasi 

Observasi adalah metode atau cara-cara menganalisis dengan 

mengadakan pencatatan secara sistematis mengenai tindakan pengamatan 

dengan melihat atau mengamati individu atau kelompok secara langsung.  

Menurut pendapat Sutrisono Hadi (1986) bahwa observasi 

merupakan “suatu proses yang kompleks, suatu proses yang tersusun 

dari berbagai proses biologis dan psikologis”.13 

 

Penelitian ini peneliti menggunakan teknik pengumpulan data 

obseravasi yang digunakan untuk memperoleh data proses selama proses 

pembelajaran berlangsung dan juga keterlaksanaan penggunaan worksheet 

materi asam basa. (pedoman observasi dapat dilihat pada lampiran II) 

c. Wawancara 

Wawancara adalah sebuah dialog yang dilakukan oleh 

pewawancara untuk memperoleh informasi dari responden.14 Jenis yang 

digunakan adalah wawancara terpimpin, pewawancara telah menyusun 

terlebih dahulu, yang bertujuan untuk mengiringi penjawab pada informasi-

informasi yang diperlukan saja.  

Upaya ini dilakukan untuk mendapatkan data dari responden yang 

dapat memberikan informasi atau penjelasan tentang keterangan-keterangan 

yang dilakukan oleh peneliti, diantaranya staf tata usaha dan pengajar untuk 

memperoleh jadwal pelajaran kimia dan waktu pelaksanaan penelitian. 

(pedoman wawancara dapat dilihat pada lampiran III) 

                                                             
13 Basrowi & Suwandi, Memahami Penelitian Kualitatif, (Jakarta: Rineka Cipta, 2008), h. 

93-96 
14 Anas Sudiyono, Pengantar Evaluasi Pendidikan, (Jakarta: Raja Grafindo Persada, 

2005) h.76 
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d. Dokumentasi 

Dokumentasi merupakan kumpulan atau jumlah signifikan dari 

bahan tertulis ataupun film (berbeda dari catatan), berupa data yang akan 

ditulis, dilihat, disimpan, dan digulirkan dalam penelitian, yang 

dipersiapakan karena adanya permintaan seseorang peneliti yang rinci dan 

mencakup segala keperluan data yang diteliti, dan mudah diakses.15 Metode 

dokumentasi ini adalah cara pengumpulan data yang menghasilkan catatan-

catatan penting yang berhubungan dengan masalah yang diteliti, sehingga 

akan diperoleh data yang lengkap, sah dan bukan berdasarkan perkiraan. 

Metode ini bertujuan untuk mengumpulkan data yang sudah tersedia dalam 

catatan dokumen. 

Metode dokumentasi dalam penelitian ini digunakan untuk 

mengetahui dan mencatat hal-hal yang berkaitan dengan data yang 

diperlukan dalam penelitian seperti soal-soal yang digunakan untuk tes hasil 

belajar materi asam basa mata pelajaran kimia kelas XI MIA, daftar nama 

siswa, jumlah siswa, dan semua data yang diperlukan dalam penelitian. Data 

yang diperoleh dianalisis untuk menentukan data kuantitatif yang 

selanjutnya diolah untuk menguji hipotesis. 

Lebih jelas mengenai data, sumber data, dan teknik pengumpulan 

data, dapat dilihat pada tabel VIII berikut. (pedoman dokumentasi dapat 

dilihat pada lampiran II). 

  

                                                             
15 Albi Anggito & John Setiawan, Metodologi Penelitian Kualitatif, (Jawa Barat: CV Jejak, 

2018), h. 146 
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Tabel VIII Matriks Data, Sumber Data, dan Teknik Pengumpulan 

Data 

No Data Sumber Data Teknik 

Pengumpulan 

Data 

1 Data Primer 

a. Data dari hasil pretest 

kelas kontrol dan kelas 

ekperimen yang 

berkenaan dengan 

kemampuan awal siswa 

dalam memahami materi 

asam basa. 

b. Data dari hasil posttest  

kelas kontrol dan kelas 

eksperimen yang 

berkenaan dengan hasil 

belajar siswa dalam 

memahami materi asam 

basa.  

 

 

 

 

 

 

 

Siswa kelas XI 

MIA 3 dan 4 

 

 

 

 

 

 

 

Tes 

2 Data Sekunder, Meliputi: 

- Gambaran umum SMAN 

9 Banjarmasin 

- Visi dan misi sekolah 

SMAN 9 Banjarmasin 

- Keadaan siswa, guru dan 

staf tata usaha SMAN 9 

Banjarmasin 

 

 

 

Responden, 

informan dan 

dokumenter 

 

 

 

Observasi, 

wawancara dan  

dokumentasi 

 

E. Teknik Pengolahan Data dan Analisis Data 

1.  Teknik Pengolahan Data Sebelum Penelitian 

a. Pengujian Instrumen Tes 

Uji coba instrumen merupakan bagian yang penting, hal ini karena 

suatu alat penelitian (tes) dapat dikatakan mempunyai kualitas yang baik 

apabila alat tersebut memenuhi dua hal, yakni ketepatan (validasi) dan 

ketetapan (reabilitas). Jadi, instrumen dikatakan baik apabila valid dan 

reliabel. Karena itu sebelum instrumen digunakan untuk pengambilan data 
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penelitian, terlebih dahulu dilakukan uji coba. Instrumen ini akan diuji 

cobakan kepada siswa yang telah menempuh mata pelajaran kimia materi 

asam basa. Maka peneliti menentukan untuk instrumen tes/soal ini akan 

diuji cobakan kepada siswa kelas XII MIA di SMAN 9 Banjarmasin. 

1). Uji Validitas 

a) Uji validitas kepada tim ahli 

Sebelum melaksanakan pengujian soal ke SMAN 9 Banjarmasin, terlebih 

dahulu soal-soal tersebut di uji validitasnya kepada tim ahli yaitu kepada 

2 Dosen Fakultas Tarbiyah dan Keguruan UIN Antasari Banjarmasin Ibu 

Ratna Kartika Irawati., S.Pd., M.Pd., dan Ibu Khairiatul Muna., M.Pd., 

dan 1 orang guru kimia dari SMAN 9 Banjarmasin Ibu Fatimah., S.Pd. 

Uji validitas tim ahli ini dilakukan oleh validator yang diminta untuk 

memvalidasi  butir-butir soal uji coba pretest dan posttest. Hasil validasi 

dari tim ahli/validator dapat dilihat pada tabel IX berikut. (untuk lebih 

rincinya bisa dilihat pada lampiran V) 

Tabel IX Hasil Validasi Soal Oleh Tim Validator 

No Nama Validator Presentase Rata-Rata 

1 Ratna Kartika Irawati., S.Pd., M.Pd 81,1% 

2 Khairiatul Muna., M.Pd 81,1% 

3 Fatimah., S.Pd 97,4% 

Presentase Keseluruhan 86,5% 

 

Presentase keseluruan yang didapat dari hasil rata-rata ketiga tim 

ahli/validator adalah 86,5%. Hasil tersebut kemudian diinterprestasikan 

berdasarkan kategori kelayakan pada tabel X di bawah ini.  
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Tabel X Kategori Kelayakan16 

Presentase (%) Kategori Kelayakan 

< 21% Sangat tidak layak 

21% - 40% Tidak layak 

41% - 60% Cukup layak 

61% - 80% Layak 

81% - 100% Sangat layak 

  

Hasil presentase keseluruhan sebesar 86,5% berdasarkan tabel IX 

kategori kelayakan dinyatakan sangat layak, maka instrumen soal dapat 

digunakan untuk uji validitas ke siswa. 

b) Uji validitas soal 

Uji validitas adalah untuk mengukur ketepatan yang dimiliki oleh sebutir 

item dalam mengukur yang harus diukur lewat butir item tersebut. Setelah 

soal diuji cobakan ke siswa, selanjutnya setiap butir-butir soal  dianalisis 

kevalidannya. Mengetahui validitas suatu instrumen soal pada penelitian 

ini menggunakan SPSS 22  for windows. Berikut langkah-langkah 

analisis pada SPSS: 

(1) Klik Start > All Programs > IBM SPSS Statistics. 

(2) Kotak dialog SPSS akan terbuka, lalu klik tombol cancel untuk 

membuat data baru. 

(3) Pada halaman SPSS terdapat dua sheet, yaitu Data View (untuk 

memasukkan data) dan Variabel View (untuk mendefinisikan 

variabel). Langkah pertama adalah mendefinisikan varibel.  

                                                             
16 Suharsimi Arikunto, Prosedur Penelitian Suatu Praktik, (Jakarta: Rineka Cipta, 2009), 

h. 44 
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(4) Langkah selanjutnya adalah menginput data di sheet Data View. 

Klik Data View, lalu isikan data ITEM1 sampai seterusnya pada 

variabel yang sesuai.  

(5) Untuk analisis data, klik menu Analyze > Corralate > Bivariate. 

(6) Pada kotak dialog Bivariate Correlations, Masukkan ITEM1 dan 

seterusnya kekotak Variables. 

(7) Pada Correlation Coefficients beri tanda centang pada pilihan 

Pearson.  

(8) Pada Test of Significance beri tanda centang pada pilihan two-

tailed  

(9) Klik OK. 

(10) Hasil Output . 

Untuk  menginterprestasikan atau menjelaskan hasil pengujian uji 

validitas yaitu dengan langkah-langkah sebagai berikut : 

(1) Mencari nilai r tabel terlebih dahulu. Sesuai ketentuan dari df (N-

2, 0,05). N adalah jumlah data yang diuji. 

(2) Membandingkan nilai rtabel dan rhitung sesuai kriteria pengujian 

yaitu, jika rtabel > rhitung maka alat ukur yang digunakan valid, 

sebaliknya jika rtabel < rhitung maka alat ukur yang digunakan tidak 

valid.17 

  

                                                             
17 Albert Kurniawan, Belajar Mudah SPSS untuk Mahasiswa dan Umum Disertai Latihan 

Soal dan Kunci Jawaban, (Yogyakarta: MediaKom, 2009), h. 178 
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2). Uji Reliabilitas 

Analisis reliabilitas mengkaji keajegan (stability) atau ketepatan hasil 

tes manakah yang dapat diujikan kepada siswa yang sama lebih dari satu 

kali. Untuk mencari reliabilitas instrumen pada penelitian ini, peneliti 

menggunakan uji reabilitas metode Cronbach’s Alpha dengan SPSS 22  for 

windows. Berikut langkah-langkah analisis pada SPSS: 

(1) Menggunakan Input data pada uji validitas. 

(2) Klik menu Analyze > Scale > Reliability Analysis. 

(3) Lalu akan mencul tampilan Reability Analysis. Pindahkan ITEM yang 

dinyatakan Valid ke kolom Items (ke sebelah kanan) dan pilih model 

Alpha.  

(4) Klik Statistics, akan muncul tampilan Reability Analysis: Statistics, 

kemudian pada bagian Descriptive For centang Scale dan Scale if item 

deleted. 

(5) Klik Continue, kemudian klik OK. 

(6) Hasil Output.18 

Untuk menginterprestasikan atau menjelaskan hasil pengujian uji 

reabilitas yaitu dengan membandingkan perhitungan rhitung dengan rtabel 5%. 

Jika rhitung > rtabel 5% maka data tersebut reliabel. Dimana rhitung dilihat dari 

tabel hasil perhitungan yang didapatkan pada SPSS, sedangkan rtabel 5% 

dilihat pada tabel distribusi nilai rtabel signikansi. 

  

                                                             
18 Ibid., h.179 
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b. Hasil Uji Coba Tes 

Sebelum melaksanakan penelitian, terlebih dahulu peneliti 

mengadakan uji coba instrumen. Pelaksanaan uji coba instrumen ini pada 

hari senin tanggal 3 Maret 2021 Pukul 09.00-10.00 WITA dengan jumlah 

peserta uji coba sebanyak 31 orang dari kelas XII MIA SMAN 9 

Banjarmasin, dilaksanakan secara online dengan mengakses link berikut 

http://bit.ly/SOALVALIDITAS. Instrumen terdiri dari 25 soal pilihan ganda 

(bisa dilihat pada lampiran II halaman 99-114).Dari hasil tes uji coba 

diperoleh data yang kemudian dilakukan perhitungan untuk validitas dan 

reliabilitas instrumen.  

1) Hasil uji validitas 

Berikut tabel XI data hasil uji validitas instrumen soal menggunakan SPSS 

22 for windows : (untuk data perhitungan lebih lengkapnya dapat dilihat 

pada lampiran VI). 

Tabel XI Hasil Uji Validitas Instrumen Soal 

Nomor 

Butir/Soal 

rhitung < / > rtabel Keterangan 

1 0,461 > 0,355 Valid 

2 0,724 > 0,355 Valid 

3 0,664 > 0,355 Valid 

4 0,542 > 0,355 Valid 

5 0,660 > 0,355 Valid 

6 0,194 < 0,355 Tidak Valid 

7 0,704 > 0,355 Valid 

8 0,687 > 0,355 Valid 

9 0,633 > 0,355 Valid 

10 -0,343 < 0,355 Tidak Valid 

11 0,776 > 0,355 Valid 

12 -0,173 < 0,355 Tidak Valid 

13 0,856 > 0,355 Valid 

14 0,708 > 0,355 Valid 
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15 0,734 > 0,355 Valid 

16 0,778 > 0,355 Valid 

17 -0,370 < 0,355 Tidak Valid 

18 0,798 > 0,355 Valid 

19 0,256 < 0,355 Tidak Valid 

20 0,927 > 0,355 Valid 

21 0,736 > 0,355 Valid 

22 0,850 > 0,355 Valid 

23 0,654 > 0,355 Valid 

24 0,577 > 0,355 Valid 

25 0,530 > 0,355 Valid 

* Nilai rtabel diperoleh menggunakan ketentuan : rtabel = df (N-2, 0,05) = (31-

2, 0,05) = 0,355 (untuk tabel tingkat signifikansi rtabel dapat dilihat pada 

lampiran XXIII) 

 

Berdasarkan tabel XI hasil uji validitas di atas, dapat disimpulkan 

bahwa butir soal nomor 1, 2, 3, 4, 5, 7, 8, 9, 11, 13, 14, 15, 16, 18, 20, 21, 

22, 23, 24, 25 dikatakan valid karena nilai rhitung > rtabel, Sedangkan butir 

soal nomor 6, 10, 12, 17, 19 dikatakan  tidak valid karena nilai rhitung < rtabel. 

Maka dari 25 soal hanya ada 20 soal yang memenuhi kriteria sebagai soal 

yang valid. 

2) Hasil uji reliabilitas 

Setelah mendapatkan butir soal yang valid maka uji selanjutnya adalah 

menggunakan uji reliabilitas. Uji reliabilitas digunakan untuk mengetahui 

konsistensi alat ukur, apakah alat ukur tetap konsisten jika pengukuran 

tersebut diulang. Alat ukur dikatakan reliabel jika menghasilkan hasil yang 

sama meskipun dilakukan pengukuran berkali-kali. Berikut tabel XII hasil 

Output SPSS 22 uji reliabilitas metode Cronbach’s Alpha menggunakan 

SPSS 22 for windows. 

Lanjutan Tabel XI Hasil Uji Validitas Instrumen Soal 

 SMAN 9 Banjarmasin 
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Tabel XII  

Case Processing Summary 

 N % 

Cases Valid 31 100.0 

Excludeda 0 .0 

Total 31 100.0 

a. Listwise deletion based on all 

variables in the procedure. 

 
Pada tabel XII case prosessing summary dapat dilihat basis cases valid 

menyatakan bahwa jumlah responden ada 31 dan persentase menunjukkan 

100%, hal ini menandakan bahwa 10 responden valid dan tidak ada 

responden yang masuk ke kategori exculded. Untuk mengetahui hasil 

perhitungan data reliabel perhatikan pada tabel XIII Reability Statistics 

berikut ini. 

Tabel XIII  

Reliability Statistics 

Cronbach's 

Alpha N of Items 

.947 20 

 

Hasil perhitungan uji reliabilitas metode Cronbach’s Alpha (rhitung) dapat 

dilihat pada kolom Cronbach’s Alpha, yaitu 0.947 dengan N of Items 

menunjukkan bahwa jumlah dari instrumen soal valid yang ditambahkan 

pada kolom Items pada dialog Reliability Analysis adalah 20. Sehingga 

dapat diketahui bahwa hasil Cronbach’s Alpha dari 20 Items adalah 0.947. 

Mengetahui data tersebut reliabel atau tidak, bandingkan nilai rhitung  dan 

rtabel 5%. Diketahui nilai N = 20 maka lihatlah berapa nilai rtabel 5% pada 
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tabel distribusi nilai (tabel distribusi nilai rtabel signifikansi 5% dan 1% dapat 

dilihat pada lampiran XXI halaman 258-259) N (rtabel) = 0,444 dan rhitung = 

0,947. Maka dapat disimpulkan bahwa rhitung > r tabel 5% = 0,947 > 0,444, 

sehingga instrumen soal tersebut adalah reliabel. (untuk perhitungan lebih 

lengkapnya dapat dilihat pada lampiran VII). 

c. Pemberian Skor 

Hasil belajar siswa diukur melalui tes yang dilakukan sebanyak 2 kali, 

yaitu tes sebelum perlakuan (pretest) dan tes sesudah perlakuan (posttest). 

Soal yang diberikan sama, baik untuk sebelum maupun yang sesudah yaitu 

terdiri dari 20 soal pilihan ganda. Pemberian skor untuk soal pilihan ganda 

lebih rincinya dapat dilihat pada tabel XIV berikut. 

Tabel XIV Pemberian Skor Instrumen Soal 

Bentuk Soal Jumlah Soal Nomor Soal Skor untuk 

Setiap Soal 

Total 

Pilihan Ganda 20 1-20 5 100 

 

Setelah mendapatkan nilai siswa, maka nilai tersebut akan 

diklasifikasikan dengan kategori interprestasi belajar pada tabel XV berikut. 

Tabel XV Interprestasi Belajar19 

Nilai Kualifikasi 

95,00 - 100 Istimewa 

80,00 - < 95,00 Amat baik 

65,00 - < 80,00 Baik 

55,00 - < 65,00 Cukup 

40,00 - < 55,00 Kurang 

0,00 - < 40,00 Amat kurang 

                                                             
19 Kepala Dinas Pendidikan Kalimantan Selatan, Pedoman Penyelenggaraan Ujian 

Sekolah dan Ujian Akhir Bagi Sekolah/Madrasah Tahun 2003/2004 Provinsi Kalimantan Selatan, 

(Banjarmasin: Pemerintahan Provinsi Kalsel Dinas Pendidikan, 2004), h.27 
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Hasil yang diperoleh akan diberikan persentase dengan menggunakan 

rumus berikut. 

𝑃 =  
𝐹

𝑁
 𝑋 100 % 

Keterangan: 

P = Angka persentase 

F = Frekuensi yang sedang dicari persentase nya 

N= Jumlah frekuensi20 

Nilai yang didapat akan diproses dengan uji statistik untuk mengetahui 

ada tidaknya perbedaan yang signifikan dari hasil belajar menggunakan 

worksheet materi asam basa berbasis kearifan lokal yang akan dijelaskan 

secara rinci pada teknik analisis data. 

2. Teknik Pengolahan Data Setelah Penelitian 

Data yang diperoleh dari hasil penelitian ini diolah dengan teknik sebagai 

berikut:  

a. Editing data, yaitu data yang telah terkumpul dari lapangan, baik berupa 

berkas-berkas catatan informasi dari hasil observasi, wawancara maupun 

data dokumenter kemudian diedit, yaitu diteliti kembali satu persatu apakah 

data tersebut valid dan reliable atau tidak. Kegiatan editing data, hal yang 

perlu diperhatikan antara lain: tentang kelengkapan pengisian data, 

                                                             
20 Murdan, Statistik Pendidikan dan Aplikasinya, (Banjarmasin: Cyprus,2006), h. 26 
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keterbacaan tulisan, kejelasan makna, keajegan dan kesesuaian jawaban satu 

sama lain, relevansi jawaban dan keseragaman satuan data. 

b. Koding data, bila tahap editing selesai, maka kegiatan koding data dapat 

dilakukan yaitu usai mengklasifikasikan jawaban-jawaban responden 

menurut jenis, sifat dan macamnya. Dengan demikian, melakukan koding 

data berarti menetapkan kategori jawaban mana yang sebenarnya tepat bagi 

suatu jawaban terhadap objek tertentu. 

c. Tabulasi adalah menyusun ke dalam bentuk tabel. Data yang berserakan 

dapat disusun dan dirangkum sehingga dapat dibaca. Maka proses tabulasi 

merupakan langkah penting, yaitu menyusun data yang berserakan menjadi 

tersusun dalam bentuk tabel sehingga memaksa data untuk dapat 

“berbicara” dalam keadaan yang ringkas, dan tersusun ke dalam suatu tabel 

yang baik, data dapat dibaca dengan mudah dan maknanya pun dapat 

dengan mudah dipahami.21 

3. Teknik Analisis Data 

Teknik analisis data dimaksudkan untuk mencari jawaban atas pertanyaan 

penelitian tentang permasalahan yang telah dirumuskan sebelumnya. 

Pendekatan yang digunakan dalam penelitian ini adalah pendekatan kuantitatif, 

maka analisis datanya menggunakan teknik analisis statistik. Statistika analitik 

yang digunakan adalah uji normalitas, homogenitas, uji independent sample t-

test dan N-Gain score. Sebelum mengadakan uji tersebut terlebih dahulu 

dilakukan perhitungan statistik deskriptif yang meliputi mean, standar deviasi, 

                                                             
21 Syofian Siregar, Statistik Deskriptif untuk Penelitian, Op.Cit., h. 206-208 
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varians, nilai minimum dan maksimum. Analisis data menggunakan SPSS 22 

for windows melalui langkah-langkah sebagai berikut: 

a. Memasukkan data ke SPSS, buka lembar kerja baru klik File > New > 

Data, terlihat tampilan Variebale View kemudian masukkan Name dan 

Property Variable. 

b. Setelah nama variable didefinisikan, langkah selanjutnya adalah mengisi 

data hasil pretest/posttest. Untuk itu kembalilah pada tampilan Data 

View. 

c. Pilih Analyze > Descriptive Statistic > Explore, lalu pindahkan nilai 

pretest/posttest ke kotak Dependet List dan kelas ke kotak List, 

kemudian pada Display klik OK. 

d. Hasil Output. 22 

1) Uji Normalitas 

Data kuantitatif yang termasuk dalam pengukuran data skala interval 

atau rasio, untuk dapat dilakukan uji statistik parametik dipersyaratkan 

distribusi normal. Pembuktian data berdistribusi normal tersebut perlu 

dilakukan uji normalitas terhadap data. Pengujian normalitas data yang 

diperoleh dalam penelitian menggunakan uji Kolmogorov Smirnov dengan 

langkah-langkah berikut. 

Langkah-langkah pengujian normalitas ini, peneliti menggunakan SPSS 22 

for windows : 

                                                             
22 Ibid., h.39-43 
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a) Masuk program SPSS. 

b) Klik Variable Views pada SPSS data editor. 

c) Pada kolom Name baris pertama ketik PRETEST KK/KE dan pada 

baris kedua ketik POSTTEST KK/KE. 

d) Pada kolom Type pilih Numeric dan pada kolom Decimals pilih 0. 

e) Masukkan  data ke dalam Data View. 

f) Klik  Analyze > Nonparametric Test > Legacy Dialogs > 1-Sample k-

s. 

g) Masukkan PRETEST/POSTTESTKK dan PRETEST/POSTTESTKE 

ke kotak Test Variable List. 

h) Klik Exact Test pilih Exact, kemudian klik Continue dan OK. 

i) Hasil Output. 

Analisis: 

Output Test of Normality 

Bagian ini akan menguji normal tidaknya sebuah distribusi data, dengan 

pedoman pengambilan keuputusan: 

a) Lihat nilai Exact Sig. (2-tailed). Jika Sig. > 0,05 maka data berdistribusi 

normal. 

b) Lihat nilai Exact Sig. (2-tailed). Jika Sig. < 0,05 maka data tidak 

berdistribusi normal.23 

  

                                                             
23 Cyrus R. Mehta dan Nitin R. Patel, IBM SPSS Exact Tests, (Copyright SPSS Inc, 1989, 

2010), h. 30 

Nuryandi., dkk, Dasar-Dasar Statistik Penelitian, (Yogyakarta: Gramasurya, 2017), h. 87-

89 
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2) Uji Homogenitas 

Setelah data berdistribusi normal, selanjutnya diadakan uji 

homogenitas. Pengujiann uji homogenitas bertujuan untuk mencari tahu 

apakah dari beberapa kelompok data penelitian memiliki varians yang sama 

atau tidak. Dengan kata lain, homogenitas berarti bahwa himpunan data 

yang kita teliti memiliki karakteristik yang sama. Berikut langkah-langkah 

uji homogenitas dengan uji Levene Statistic menggunakan SPSS 22 for 

windows: 

a) Masuk program SPSS. 

b) Klik Varible Views pada SPSS data editor. 

c) Pada kolom Name baris pertama ketik pretest/posttest dan pada kolom 

baris kedua kelas. 

d) Pada kolom Type pilih Numeric untuk pretest/posttest dan kelas. Pada 

kolom Decimals pilih 0 untuk pretest/posttest dan kelas. 

e) Atur Values untuk kolom Kelas, value 1 untuk label kontrol dan value 2 

untuk label eksperimen. 

f) Ketikkan data sesuai variabelnya. 

g) Klik  Analyze > Desciptive Statistics > Explore. 

h) Klik variabel pretest/posttest dan masukkan ke kotak Dependent List. 

i) Klik variabel kelas dan masukkan ke kotak Factor List. Kemudian klik 

Plots. 

j) Pada Boxplots beri tanda centang pada pilihan factor levels together. 
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k) Pada Spread Vs Level with Level Test beri tanda centang pada pilihan 

Untransformed. 

l) Pada Desriptive beri tanda centang pada pilihan Stem-and-leat. 

m) Klik Continue dan OK. 

n) Hasil Output. 

Cara menafsirkan Uji homogenitas Levene Statistic adalah dengan melihat 

nilai pada kolom Sig. baris Based on Mean > 0,05 maka dapat dikatakan 

bahwa variasi data adalah homogen.24 

3) Uji-t 

Pada penelitian ini, Uji-t yang digunakan adalah Independent sample 

t-test. Uji Independent sample t-test merupakan bagian dari statistik 

inferensial parametrik (uji beda atau uji perbandingan). Statistik parametrik 

terdapat syarat-syarat yang harus terpenuhi sebelum melakukan pengujian 

hipotesis (dalam uji hipotesis menggunakan uji independent sample t-test). 

Uji independent sample t-test memiliki asumsi/syarat yang mesti dipenuhi, 

yaitu: 

a) Kedua sampel tidak berpasangan. 

b) Jumlah data untuk masing-masing sampel kurang dari 30 buah. 

c) Data yang dipakai dalam uji ini berupa data data kuantitatif berskala 

interval atau rasio. 

d) Data untuk kedua sampel berdistribusi normal. 

                                                             
24 Nuryandi., dkk, Dasar-Dasar Statistik Penelitian, (Yogyakarta: Gramasurya, 2017), 

h.93  
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e) Adanya kesamaan varians atau homogen untuk kedua sampel data 

penelitian (bukan merupakan syarat mutlak). Jika ternyata didapati 

varians data kedua sampel tidak homogen, maka uji independent 

sampel t-test tetap dapat dilakukan. Akan tetapi pengambilan keputusan 

didasarkan pada hasil yang terdapat dalam tabel output SPSS “Equal 

varianve not assumed”. 

Langkah-langkah pengujian uji independent sampel t-test peneliti 

menggunakan perhitungan SPSS 22 for windows : 

a) Memasukkan data pada Data View, namun sebelumnya harus 

menentukan nama dan tipe datanya pada Variable View. Misal : Nilai 

(PRETEST/POSTEST) Kelas ( 1 dan 2). 

b) Klik menu Analyze > Compare Means > Independent Sample T-Test 

c) Masukkan PRETEST/POSTTEST ke Test Variabel dan Kelas ke 

Grouping Variabel . 

d) Klik Define Groups, pada Use Specified Values masukkan angka “1” 

pada group 1 dan angka “2” pada group 2. Kemudian klik Continue. 

e) Klik Options dan pada Interval Confidence masukkan 95% (karena α 

= 0,05). Kemudian klik Continue. 

f) Kemudian klik Ok. 

g) Hasil Output.25 

  

                                                             
25 Ibid., h.111-113 



65 

 

 

 

Analisis pengambilan keputusan: 

a) Merumuskan hipotesis: 

H0 : Tidak terdapat perbedaan hasil pretest/posttest kelas kontrol dan 

kelas ekperimen. 

Ha : Terdapat perbedaan hasil pretest/posttest kelas kontrol dan kelas 

ekperimen. 

b) Menentukan t hitung, nilai t-hitung dapat dilihat pada tabel t baris equal 

variance assumed (jika data berdistribusi normal dan homogen) / equal 

variance not assumed (jika data berdistribusi normal dan tidak 

homogen). 

c) Menentukan t-tabel. T-tabel dapat dilihat pada tabel statistik pada 

signifikansi 0,05:2 = 0,025 (uji 2 sisi) dengan derajat kebebasan (df) n-

2. 

d) Membuat kesimpulan. Jika t hitung < t tabel maka H0 ditolak, sebaliknya 

t hitung > t tabel maka H0 diterima.26 

4) Uji Normalize Gain atau N-Gain Score 

Uji n-gain score bertujuan untuk mengetahui pengaruh penggunaan 

suatu metode atau perlakuan (treatment) tertentu dalam penelitian one 

group pretest posttest design (ekperimen design atau pre-experimental 

design) maupun penelitian menggunakan kelompok kontrol (quasi 

eksperimen atau true ekperimen). Uji N-gain score dilakukan dengan cara 

                                                             
26 Duwi Priyatno, Cara Kilat Belajar Analisis Data dengan SPSS 20, (Yogyakarta: C.V 

Andi Offset, 2012), h.83-84 
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menghitung selisih antara nilai pretest (tes sebelum diterapkan perlakuan) 

dan nilai posttest (tes sesudah perlakuan). Menghitung selisih antara nilai 

pretest dan posttest atau gain score tersebut, untuk mengetahui pengaruh 

pengunaan atau penerapan suatu metode tertentu dapat dikatakan 

berpengaruh atau tidak. Kategori perolehan nilai N-gain score dapat 

dikategorikan dengan pembagian skor Gain dapat dilihat dari tabel XVI 

berikut: 

Tabel XVI Kategori Pembagian Skor Gain27 

Nilai N-Gain Kategori 

g > 0,7 Tinggi 

0,3 ≤ g ≤ 0,7 Sedang 

g > 0,3 Rendah 

 

Langkah-langkah uji N-gain score, peneliti menggunakan 

perhitungan SPSS 22 for windows : 

a) Buka program SPSS, lalu Input data ke Data View. 

b) Kemudian menghitung selisih nilai pretest dan posttest pada kelas 

kontrol dan kelas eksperimen. Dengan klik menu Transorm > Compute 

Varible. 

c) Pada dialog (Compute Variable) pada kotak Target Variabel ketikan 

(Post_Kurang_Pre) pada kotak Numeric Expression ketikkan (post-

pre) lalu klik OK. 

                                                             
27 Rahmawati, dan Melisa, “Pengaruh Penenrapan Pendekatan Konsektual Bermedia 

Power Point Terhadap Hasil Belajar Siswa Pada Materi Sistem Ekskresi Pada Manusia Kelas VII 

SMP 4 Bireuen”. dalam Jurnal JESBIO, Vol. V, No.1, 2016. 
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d) Klik menu Transform > Compute Variable, hapus tulisan pada kotak 

Target Variabel lalu ketik (Seratus_Kurang_Pre) kemudian hapus 

tulisan pada kotak Numeric Expression lalu ketikkan (100-pre), 

kemudian klik OK. 

e) Klik menu Transform > Compute Variable, hapus tulisan pada kotak 

Target Variabel lalu ketik (NGain_Score) kemudian hapus tulisan pada 

kotak Numeric Expression lalu ketikkan 

(Post_Kurang_Pre/Seratus_Kurang_Pre), kemudian klik OK. 

f) Kemudian menghitung rata-rata nilai N-Gain score. Dengan klik 

Analyze > Descriptive Statistics > Explore. 

g) Muncul kotak dialog (Explore), kemudian masukkan variabel kelas ke 

kotak Factor List, lalu masukkan variabel NGain_Score ke kotak 

Dependent List, pada bagian Display pilih Both, Kemudian klik OK. 

h) Hasil Output. 

F. Prosedur Penelitian 

Prosedural dalam penelitian ini terbagi dalam beberapa tahap yaitu: 

1. Tahap Perencanaan 

a. Penjajakan lokasi penelitian dengan berkonsultasi dengan guru kimia 

SMAN 9 Banjarmasin untuk menentukan masalah. 

b. Berkonsultasi dengan pembimbing akademik lalu membuat desain proposal. 

c. Mengajukan proposal skripsi kepada pihak fakultas untuk memohon 

persetujuan judul. 
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2. Tahap Pesiapan 

a. Mengonsultasikan desain proposal skripsi. 

b. Mengadakan seminar desain proposal skripsi. 

c. Memperbaiki proposal berdasarkan hasil seminar. 

d. Melakukan uji coba instrumen tes. 

e. Memohon surat riset kepada Dekan Fakultas Tarbiyah dan Keguruan. 

f. Menyerahkan surat riset kepada kepala sekolah yang bersangkutan dan 

berkonsultasi dengan guru kimia. 

g. Melakukan pengumpulan data awal siswa kelas XI MIA SMAN 9 

Banjarmasin. 

h. Menyiapakan worksheet untuk proses belajar dan pembelajaran. 

3. Tahap Pelaksanaan 

a. Melaksanakan penelitian sesuai jadwal yang ditentukan. 

b. Mengumpulkan data. 

c. Mengolah data yang sudah dikumpulkan. 

d. Melakukan analisis data. 

4. Tahap Penyusunan Laporan 

a. Penyusunan hasil laporan dalam bentuk skripsi. 

b. Berkonsultasi dengan pembimbing skripsi untuk perbaikan dan persetujuan 

untuk disidangkan. 

c. Selanjutnya akan dipertanggung jawabkan pada munaqasah skripsi.


